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COPYRIGHT NOTICE 

© Trevor Caswell   2005-2008     All rights reserved 

Copyright exists on the contents of this manual and the software ‘PlePcat.exe’ supplied on 
the accompanying electronic media.  You agree by purchasing the software to use it on 
only one machine.  However, it may be transferred and used on another machine, but shall 
under no circumstances be used on more than one machine at a time.  One copy can be 
made of the software into any machine readable form for backup purposes only in support 
of your use of the software on a single machine. 

 

 

DISCLAIMER OF WARRANTY 

The software and manual are sold AS IS and without warranty as to performance.  
Because of the use to which this software may be put, and the variety of luminaires and 
hardware used in conjunction with it, no warranty of fitness for a particular purpose is 
offered.  Whilst the developer has invested considerable time and effort to create a high 
quality product, the user must assume the risk of using this software. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Trevor Caswell Software 
P.O. Box 236 

SALISBURY,  Qld 4107 
Australia 

Ph. & Fax.:  (07) 3275 2406 
Int:  +61 7  3275 2406 
Mobile:  0417 732 763 

Email:  support@perfectlite.com 
Web:  www.perfectlite.com 
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1. INTRODUCTION 
The P Category Lighting software (PlePcat) produces Spacing Tables which can be used as 
design aids in the lighting of Category ‘P’ roads in Australia and New Zealand.  Category ‘P’ was 
originally introduced in the revised Road Lighting Standard AS/NZS 1158.3.1:1999, released in 
November 1999.  This Standard has now been superceded by AS/NZS 1158.3.1:2005 which 
contains more detail as well as some minor changes and enhancements. 

It is assumed that the user has basic knowledge of the operations of the PC and the Windows 
98/NT/2000/XP/Vista operating system. 

 

2. INSTALLING THE SOFTWARE 
Depending on how the software was purchased it will be provided in either of two forms (i.e. either 
as a stand alone version or as part of the main Perfect Lite software package).  In either case, the 
P Category Lighting software will be contained on a CD-ROM and will require the following 
procedure to install the software correctly. 

First, load the CDROM into your CD Drive and then click on the Start button, Select Run… from 
the menu and type d:\PlePcat\setup.exe (d: is the drive letter of your CDROM) into the Run dialog 
box and then click OK. 

 

 
 

Follow the subsequent instructions on the screen to correctly install the P Category Lighting 
software on your computer.  Generally, it will only be necessary to click on the Next button several 
times to carry out the installation.  It is recommended you choose the default folder (c:\Program 
Files\Perfect Lite) in which to install the software. 

If you install the software in another drive and/or folder then please make a note of the location 
below for future reference. 

P Category Lighting software installed in drive/folder: 

………………………………………………………………………………………………………………….. 
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3. STARTING THE SOFTWARE 
Click on the Start button, select Programs then Perfect Lite then P Category Lighting from the 
menu.  (Note:  The menu may also show Pedestrian Area Lighting, which is still available for use, 
but the LTPs and calculation methods relate to AS/NZS 1158.3.1:1999 – the superceded 
Standard.) 

 
 

The window as shown below should then be displayed. 

 
If this is the first time you have run the software then the ‘Welcome to the Perfect Lite…..’ window 
will appear.  If you don’t want it to appear again click in the box adjacent to the text “Don’t show me 
this again”. 
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4. BRIEF TOUR OF THE SOFTWARE 
 
The P Category Lighting software (referred to as “PlePcat”) mainly produces spacing tables 
which can be used as design aids in the provision of  lighting for Category ‘P’ roads, paths and 
cycleways.  Category ‘P’ was originally introduced in 1999 when the (1986) road lighting Code, 
AS1158, was revised.  The Code has been further revised and is now known as AS/NZS 
1158.3.1:2005.  The PlePcat software has been amended to meet the changes in the Standard. 
 
Before you produce a spacing table (or generally do anything else in the software) it is necessary 
to load (or open) a photometric I-table for the luminaire under consideration.  These I-tables would 
usually be stored on your computer’s hard drive or floppy disk as a file supplied from the 
manufacturer or supplier of the luminaire.  To get you up and running the PlePcat software is 
supplied with a sample file (LUM2.cie) which corresponds to the one used in the Appendix of 
AS/NZS 1158.3.1:2005.  From the File menu click on Open I-Table. 
 

 
 
This will then display the screen where the file name is required to be input. 
 

 
 
Each time you enter this screen (and most others in the program) the fields will be filled with the 
data last input.  Should you wish to select a different file then either:- 
 
    1)   enter the name directly in the I-Table File Name field 
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    2)   click the down arrow to the right of the combo box to select from previous files used   or 
    3)   click on the Browse button to invoke the standard Window File Open Dialog Box. 
                 to select the appropriate file, example below 
 

 
 
It should be noted that by default, the dialog box will initially only display all the files with a “cie“ file 
extension (typical for road lights).  If this is not the type of file you are looking for make a choice 
from the Files of type drop down list box.  When the desired file is in the File name field click the 
Open button on the file dialog box to continue on with the software. 
 
When the desired file name has been entered click on the Next button to continue on with the 
software.  On the following screen input descriptions of the luminaire, initial flux value, maintenance 
factor, light source etc.. 
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Inputs in the description fields are only necessary for identification of the luminaire and lamp and 
will be included on any output produced by the software.  Once again when all the information has 
been entered click on the Ok button. 
 
You have now loaded the I-table file into the program and at this point you can view the 
photometric I-Table by selecting either of the top two items from the View menu. 
 

 
 
However, the main thing that we want to do is produce a spacing table (or check on compliance for 
a particular spacing).  From the Spacing Table menu select Local Roads… .  Alternatively, you 
could select Pathways (including Cycleways) from the same menu depending on your needs. 
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The screen will change to show several input fields to be filled with appropriate data relative to the 
table you wish to produce.  As this is the first time the software has been run it will have the default 
values as used in Appendix B of AS/NZS 1158.2:2005. 
 

 
 
For this Brief Tour we’ll just leave the fields as they are.  Please note in the example above that the 
User Defined LTPs check box is checked.  Normally, this check box is left un-checked for strict 
compliance with AS/NZS 1158. 
 
Now might be a good time to talk about the On-line Help accessible from within the software.  If 
you are in doubt as to what details should be input into any field then simply put the cursor in that 
field (ie. Left mouse click in the field) and press the F1 key.  A pop-up Help screen will appear 
giving you information on the contents of the field and limit of values that can be input etc.  This 
help feature is available for any item on a Menu, any button or screen displayed.  To remove the 
Help screen click on the X in top right-hand corner of the Help window.  You can check out this 
help feature for some of the fields on the current screen. 
 
Anyhow, back to the process of producing the spacing table.  Now press the Calculate button to 
get the software to carry out the necessary calculations to determine the maximum spacing for the 
range of road widths and heights etc. entered.  When Calculate is pressed the software first 
validates the data in the input fields.  If an error occurs, such as a value being out of an allowable 
range then an error message will appear such as below. 
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An example of the top part of a spacing table is shown below. 
 

 
 
Use the scroll bar on the right side of the screen to move the display up to view the remainder of 
the table. 
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To print out the complete table on your printer click on the Print button and the standard Windows 
print dialog box will be displayed.  Alternatively, you can save the results to a text file by clicking on 
the Save As button. 
 

 
 
Select an appropriate printer and click on the Ok button to send the printout.  Once the printout has 
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been produced click on the Close button to remove the calculated results and return to the screen 
where you can change some values and produce another table.  If you don’t want to produce 
another table then just click on the Cancel button.  This will take you back to the point where you 
can make a selection from the menu along the top of the PlePcat window. 
 
To close down the program altogether select from the File menu the Exit option or click on the X in 
the top right-hand corner of the PlePcat window. 
 

 
 
The other choices from the menu along the top of the window are self explanatory so I won’t go 
into detail here.  If you have doubts then place the cursor over the required menu item and while 
holding down the left mouse button press the F1 key and a pop-up Help screen will be displayed.  
An example of the one for the Tools Menu is below. 
 

 
 
Should you have any problems using this software or would like to offer suggestions on future 
enhancements contact me on Ph.:  07 3275 2406 or Email:  trevor@perfectlite.com. 
 
Trevor Caswell 
October 2008 
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5. UPDATE HISTORY 
 

Following is a brief list of all the major changes that have taken place over the years in the Perfect 
Lite minor road lighting software. 

P CATEGORY LIGHTING (PlePcat) 

VERSION  3.04  (Released October 2008) 
• Corrects problem reading an i-table file where an intensity value is greater than 999 

VERSION  3.03 (Released November 2007) 
• Check box for the New Zealand reduced LTPs has been replaced by Category P3R & 

P4R on the Category selection drop down list box 
• Additional check box & input fields added to allow input of variable user defined Light 

Technical Parameters. 
• Checks Read/Write access is available to the user to allow program to operate correctly. 
• Lengthy Path/File name for the selected luminaire is suitably wrapped on result screens 

& printed output. 

VERSION  3.02  (Released September 2006) 
• Categories P5 to P8 able to be selected for Pathways. 
• Displays on the Luminaire Description form the de-rating factor if HPS or LPS previously 

selected. 
• Job Name field added to Local Area Roads and Pathways form. 
• Allows mounting heights down to 0.5m for Local Roads (any Upcast angle). 
• Allows mounting heights down to 0.5m for Pathways (Upcast angle must be zero) eg. 

used for Bollards. 
• Range of allowable Offset values increased between -12m and +30m to -20m and +40m. 
• Check box added to select whether to include the light contribution from adjacent 

luminaires to the span being investigated. 

VERSION  3.01  (Released November 2005 – Special version for Sylvania Lighting Australasia only) 
• Menu item ‘Luminaire Classification Report’ replaced by ‘Luminaire Intensity Report’ to 

display intensity values at specific angles in order to derive the Luminaire Classification 
Type. 

• Foreground and Background colours on some screens have been changed. 
• Shows the respective maximum ‘Maintenance Factor’ opposite the ‘Ingress Protection 

Rating’ field. 
• ‘Luminaire Classification’ field removed from the Luminaire Description input screen. 

VERSION  3.00  (Released August 2005) 

• With the introduction of AS/NZS 1158.3.1:2005 the PlePAL program has been 
superseded by the P Category Lighting software (PlePcat). 

•  ‘Miscellaneous’ menu renamed to ‘Tools’ menu and ‘Options’ item added. 
• Setting the company name has moved to the ‘Options’ menu. 
• ‘Options’ menu now includes a new item called ‘Output setup’ which is used to set the 

margin width, font name & size for all output to the printer. 
• When ‘Multi File Mode’ is activated a small tick will be shown against it in the ‘File’ menu.  

To exist ‘Multi File Mode’ simply select the item when it is ticked. 
• Maintenance factor calculation form has been changed to also include the ‘IP Rating’ and 

a ‘Lamp Depreciation factor’. 
• Luminaire Description form now includes fields for the Light Source and Luminaire 

Classification. 
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PEDESTRIAN AREA LIGHTING (PLEPAL) 

VERSION – 2.06  (Released June 2004) 
• “Multi File Mode” added which allows the automatic processing of up to 200 I-table files 

against a single set of layout parameters. 
• Due to access problems associated with Network security the configuration files (Plepal-

user.cfg) is now stored in the same folder as the program (NOT root folder of C drive). 
• Warning message is given if the Printer used for output is changed from the default 

printer. 
• Program version/Date stamp on bottom of printouts has been modified slightly. 
• Contact email address on ‘About’ screen changed. 

VERSION – 2.05  (Released May 2003) 
• Released with Perfect Lite - Version 4.86a 
• ‘Save As…’ button added to the screen where all results are viewed.  This allows you to 

save or append the results to a text file rather than printing them out. 
• Progress bar added to the Local Road and Pathways calculation screen. 
• Allows Category P1 & P2 for Local road calculations (ignores Vertical illuminance). 
• Now validates the Company name against the serial no. of the software. 
• Contact details changed on the ‘About’ screen 
• Calculation of Luminaire Classification corrected. 
• Note about compliance after ‘5 November 2001’ removed as no longer applicable. 

VERSION – 2.04  (Released May 2001) 
• Released with Perfect Lite - Version 4.84 
• When ‘tabbing’ between input fields the whole field is highlighted so if you want to 

change the whole field you simply start typing the new value rather than first erasing all 
previous text.  If you want to just change part of the field then press the <End> key and 
the highlight will disappear and you can move the cursor back to what you want to 
change data. 

• Initialisation file (“.ini”) now referred to as a Configuration file (“.cfg”) 

VERSION – 2.03b  (Released October 2000) 
• For Local Roads and an Opposite arrangement the program now allows the luminaire 

Offset to exceed half the Road Reserve width - this will simulate a Central arrangement. 

VERSION – 2.03a  (Released August 2000) 
• The bug has been fixed where the program could not be re-started and restored to full 

size if closed down (or the PC shutdown) when it is minimised. 

VERSION – 2.03  (Released May 2000) 
• A field description on the Path Spacing Table input screen has been changed from 

‘Distance from Path Edge’ to ‘Offset from Path Edge’ to remove confusion as to what the 
distance represents – see associated help screen. 

• ‘&’ character can be used in ‘Offset Distance’ and ‘Offset from Path Edge’ field to 
nominate the luminaire position as halfway across road reserve or path.  Compliments 
the ‘*’ character for one quarter across road reserve/path already built into the software. 

• A history of revisions to the software added to the Contents item on the Help menu. 
• When selecting ‘Open an I-table’ from the menu, the ‘I-Table File Name’ field has been 

changed to a drop down list box allowing the selection of the file name from one 
previously used 

VERSION – 2.02  (Released February 2000) 
• When selecting ‘Open an I-table’ from the menu, the first input screen has been changed 

to only select the required file name.  On the subsequent screen where you would 
normally input the description you now also input the flux, maintenance factor and upcast 
angle. 

• Save the values entered for ‘Luminaire Description’, ‘Lamp Wattage and Type’ and 
‘Stores Code’ against the file name so it will be automatically displayed next time the 
same luminaire is used. 

• Check box added to allow all the LTP’s at maximum spacings to be displayed on a 
separate page of the Spacing Table. 
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• Check box added to allow all the display of illuminance values at grid points of each 
maximum on separate pages of the Spacing Table. 

• The location of the PLEPAL program window on the display screen will now be restored 
to where it was located last time the program closed down. 

• Luminaire Classification changed to show if it complies after 5 November 2001. 
• A ‘Back’ button has been added to some screens & position of the ‘Next’ and ‘Back’ 

buttons swapped around on other screens. 

VERSION – 2.00  (Released November 1999) 
• Released as a result of the revision to the Australian and New Zealand Public Lighting 

code AS/NZS 1158.3.1:1999 where lighting category ‘P’ was introduced. 
• The program has been converted to a true 32 bit Windows Application and the named 

changed to Perfect Lite – Pedestrian Area Lighting (PLEPAL.EXE).  The previous MS-
DOS versions (1.60, 1.59 etc.) was known as the Spacing Graph Generator for Minor 
Roads (PLESPACE.EXE). 

SPACING GRAPH GENERATOR (PleSpace) 

VERSION - 1.63 (Released May 2001) 

• Released with Perfect Lite Version 4.84 
• Modified to do all printing through the Windows Print Manager 
• Menu added at start of program to select printer for output 
• With the introduction of AS/NZS 1158.3.1 this program has effectively been superseded 

by the Pedestrian Area Lighting software (PLEPAL) – refer separate manual detailing this 
software. 

VERSION - 1.60  (Released June 1998) 
• Released with Perfect Lite Version 4.82 
• Allows the specification of a full Path for an I-Table file 
• Standard DOS file dialogue used for file selection 
• For Mode 3 – A maintenance factor of up to 10 can be used for R-Table ‘0’ to calculate 

Lux rather than Cd/m2 

VERSION - 1.59  (Released April 1997) 
• Released with Perfect Lite Version 4.81 
• Road Width changed to go from 2m through to 40m 
• Now uses version 1.60 of PPD.EXE for printer output 

VERSION - 1.58 
• Special issue for SEQEB/Energex in Queensland 
• Rounding off of displayed results corrected 
• 'Count' column removed 
• 'Plot' & 'Redraw' option removed from graphics screen 
• Error message given if 'PPD.EXE' file not found prior to printing 
• Printer port displayed after printer description on opening screen 
• Spacing range increased to 120m on graph/plot 
• Road reserve width increased to 38m on graph/plot 
• Default Upcast angle set to 5 degrees 
• Reading default set up values from file ‘PLESPACE.TBL’ added 
• Reading from file PLESPACE.LIN now fully supported 
• Maximum spacing displayed to 1 decimal place 
• 'Emax/Eav' displayed to 1 decimal place 
• 'NO COMPLIANCE' added if Maximum spacing less than 0.005m 
• <F5> key added to select from Parameter table file 
• If PLE.HLP not found then PLESPACE.HLP used 

VERSION - 1.57  (Released July 1995) 
• Message window displayed if 0 cd/m2 found at V=0 in I-table - "/ADJ" command line 

option added to adjust values to 1 cd/m2 
• "DESCRIPTION=" line added to 'PLESPACE.INI' file 



Perfect Lite – P Category Lighting - AS/NZS 1158.3.1:2005 Version 3.04 

© Copyright Trevor Caswell 2005-2008 Page  14 

• Disables MOUSE if file 'MOUSE.NO' found 

VERSION - 1.56 
• Text 'AS1158.1 -1986' added 
• Display/Print out fixed so when NOT complying spacing 'Eav','Emin','Emax/Eav' shows 

last actual calculated values NOT last "complying" values 
• Version no. added to text results screen/print out 

VERSION - 1.55 
• Now uses version 1.42 of PPD.EXE 
• <Esc> used to abort processing of PrintGL print out 
• Colour argument of 'PSET' & 'LINE' made Long Integer 
• Configuration file now "PLE48.INI" 

VERSION - 1.54 
• Draws vertical ordinate at nominated values as in file "PLESPACE.LIN" 
• Rounding off corrected to be same as print out 

VERSION - 1.53 
• ‘Opposite’ arrangement re-instated as maximum now determined using both lights 

VERSION - 1.52 
• '/FULL' command line option added for detailed calculation output to file 
• Now support large asymmetrical I-table files 
• Problem fixed in calculating Eh behind light 
• ‘Opposite’ arrangement removed till Finding maximum is done properly 
• Undocumented '/GRID' command line option added 

VERSION - 1.51 
• Uses PLE.HLP as the Help file 
• Will use Hercules Graphics card 
• Stand alone version displays colours in Help correctly 

VERSION - 1.5  
• Use PPD.EXE instead of PRINTGL 
• Can be called from PLE.EXE (PLESPACE.INI automatically set up) 
• Released with version 4.77 of Perfect Lite 
• PPD.EXE outputs to DOS LPT? not BIOS LPT? (fixes bug with network printers) 
• Uses PLE47.INI for configuration options 

VERSION - 1.4 
• NON Intel co-processor problem fixed 

VERSION - 1.3 
• Program corrected for when no solution found for a particular road width 
• Thickness added to printer output 

VERSION - 1.2 
• PRINTGL used for graphics printer output 

VERSION - 1.1 
• Minor changes only 

VERSION - 1.0  (Released 1990) 
• Original issue 

 


